S software*

A SOFTWARE GMBH BRAND

NaturalONE

Release Notes

Version 9.3.2

October 2025

ADABAS & NATURAL



This document applies to NaturalONE Version 9.3.2 and all subsequent releases.
Specifications contained herein are subject to change and these changes will be reported in subsequent release notes or new editions.
Copyright © 2009-2025 Software GmbH, Darmstadt, Germany and/or its subsidiaries and/or its affiliates and/or their licensors.

The name Software AG and all Software GmbH product names are either trademarks or registered trademarks of Software GmbH
and/or its subsidiaries and/or its affiliates and/or their licensors. Other company and product names mentioned herein may be
trademarks of their respective owners.

Detailed information on trademarks and patents owned by Software GmbH and/or its subsidiaries is located at
https://softwareag.com/licenses.

Use of this software is subject to adherence to Software GmbH's licensing conditions and terms. These terms are part of the product
documentation, located at https://softwareag.com/licenses and/or in the root installation directory of the licensed product(s).

This software may include portions of third-party products. For third-party copyright notices, license terms, additional rights or re-
strictions, please refer to "License Texts, Copyright Notices and Disclaimers of Third-Party Products". For certain specific third-party
license restrictions, please refer to section E of the Legal Notices available under "License Terms and Conditions for Use of Software GmbH
Products / Copyright and Trademark Notices of Software GmbH Products”. These documents are part of the product documentation,
located at https://softwareag.com/licenses and/or in the root installation directory of the licensed product(s).

Use, reproduction, transfer, publication or disclosure is prohibited except as specifically provided for in your License Agreement with
Software GmbH.

Document ID: ONE-RELNOTES-932-20251002



Table of Contents

PTOACE ..t v
1 About this Documentation ...........cc.cocoiiiiiiiiiiiiiii 1
Document CONVENIONS ........ccoiiiiiiiiiiiiiiiiiiiiiiiccic e 2
Online Information and SUPPOTt .......c.ccieiiiiiiiiiii 2
Data Protection .........c..ooooiiiiiiiiiic 3
2 What's New in Version 9.3.2 ........cccooiiiiiiiiiiiiiiiiiciiciccce e 5
Enhancements ..o 6
Basic Functionality for Natural Application Development .............c.ccceiviiiiinnnnn. 9
Natural for Ajax / Ajax Developer ...........cccocooiiiiiiiiiiiiiiiiec 9
3 What's New in Version 9.3.1 ......ccccociiiiiiiiiiiiiiiiiiiccicccc e 13
ENVITONIMENE ...oooiiiiiiiii 14
Enhancements ...........cccooiiiiiiiiiiiiiii 14
Basic Functionality for Natural Application Development .............cccocooiiiiiiinninn. 15
Natural for Ajax / AjaX DeVelOPeT ........cccocuiiviiiiiiiiiiiiieiiciececct e 15
4 What's New in Version 9.2.1 ......ccccociiiiiiiiiiiiiiiiiiiciicic e 19
SOCUTIEY et 20
Enhancements ..........cccooiiiiiiiiiiiiiic 20
Basic Functionality for Natural Application Development .............c.ccccoeiiiiiinnnn. 21
Natural for Ajax / AjaX DeVelOpPer .........ccccieviiiiiiiiiiiiiiiiiiiiicecece e 21
5 What's New in Version 9.1.4 .........ccociiiiiiiiiiiiiiiiieieceieceieceiee ettt 27
SOCUTIEY oot 28
Enhancements ..........cccoooiiiiiiiiiiiiiiiiii 28
Basic Functionality for Natural Application Development .............ccccccoociiiiiinin. 29
Changes t0 the UIS .......c.cooiiiiiiiiiiiiiii e 30
Natural Tools and Utilities ............ccocoiiiiiiiiiiiiiiii, 31
Natural for Ajax / AjaX DeVelOPer ..........cocuiiviiiiiiiiiiiiieiiiiiece e 32
6 What's New in Version 9.1.3 ........cccccoiiiiiiiiiiiiiiiiiiii 35
INstallation ........ccooiiiiiiiiii 36
Basic Functionality for Natural Application Development .............cccccociiiinnninne. 36
Natural Tools and Utilities ...........cccccoiiiiiiiiiiiiiiii, 37
Deploying Natural Applications ..........c.cccceviviiiiiiiiiiiiiiiiicic e 38
Eclipse-Independent Application Testing ..........c.ccccooieviiiiiiiiiiiiiii 38
Natural for Ajax / Ajax Developer ..o 39
Optional COMPONENLS .......ccueiiiiiiiiiiiiiiiiii e 42
Documentation ..........cc.ooviiiiiiiiiiii 42
KNOwWn ISSUES ......oooiiiiiiiiiii 43
7 What's New in Version 9.1.2 .........ccccoooiiiiiiiiiiiiiiiiiiiciccc 45
Basic Functionality for Natural Application Development ...........c.cccceeviiiiinnnnnn 46
Natural Tools and Utlities ...........cccocviiiiiiiiiiiiiiiiii, 47
Natural for Ajax / Ajax Developer ..........cccocoviiiiiiiiiiiiiiiiic 48
8 What's New in Version 9.1.1 ......cccociiiiiiiiiiiiiiiiiiiiciccc e 51
Using NaturalONE in Your Own Eclipse Environment ...........c..cccoccoviiiiiiiinnn, 52
Installation ..........ccooiiiiiiiiiii 52




Release Notes

Basic Functionality for Natural Application Development .............c.coccooiiiiiiinninns 52
Deploying Natural Applications .............cccooviiiiiiiiiiiiiiiicc 54
Natural for Ajax / Ajax Developer .........cccccovviiiiiiiiiiiiiiiiiiiiiiiicciciccc e, 56
Natural Tools and Utilities ...........cccocciviiiiiiiiiiiii, 59
NaturalONE in a Citrix Environment ............ccccocoiiiiiniiiiiiiiics 59

Release Notes



Preface

These Release Notes pertain to the core functionality of NaturalONE, including Natural for Ajax
and Ajax Developer. The following topics are covered:

What's New in Version 9.3.2
What's New in Version 9.3.1
What's New in Version 9.2.1
What's New in Version 9.1.4
What's New in Version 9.1.3
What's New in Version 9.1.2
What's New in Version 9.1.1

For important last-minute information, see the readme file that is provided with Natural ONE.

] Note: The Release Notes for the NaturalONE components which can be installed optionally

are provided separately. If available, they can be found in the documentation for the
corresponding component.
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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://documenta-
tion.softwareag.com.

Product Training

You can find helpful product training material on our Learning Portal at https://learn.software-

ag.com.

Tech Community

You can collaborate with Software GmbH experts on our Tech Community website at https://tech-
community.softwareag.com. From here you can, for example:
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About this Documentation

Browse through our vast knowledge base.

Ask questions and find answers in our discussion forums.

Get the latest Software GmbH news and announcements.

® Explore our communities.

® Go to our public GitHub and Docker repositories at https://github.com/softwareag and ht-
tps://hub.docker.com/publishers/softwareag and discover additional Software GmbH resources.

Product Support

Support for Software GmbH products is provided to licensed customers via our Empower Portal
at https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

® Download products, updates and fixes.

® Search the Knowledge Center for technical information and tips.

" Subscribe to early warnings and critical alerts.

Open and update support incidents.

Add product feature requests.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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What's New in Version 9.3.2

Enhancements

This section describes new features and enhancements in NaturalONE's basic functionality for
Natural application development. It covers the following topics:

= Natural Server Search

= Extended object properties in Server View

= Debug Attach Server Available on Linux

m SSL/TLS Security for Debug Attach Server

= Deployment

= Editing a Filter or Filter Pattern for the Natural Server View

= Downloading an Existing Library or Object from a Natural Server

= Collapse All Structures in Outline View

= Status Information of Natural Server

= | ibraries with different Fuser in NSC can now be handled in one project
= Monitoring and Modifying Variables Using the Eclipse Memory View
= Changing the Value of Variables from the Editor Area

Natural Server Search

A full blown search functionality is now available for the Natural Development servers integrated
into the Eclipse search framework. Search requests such as file search, text search either with and
without replacements, as well as resource search can be executed.

Extended object properties in Server View

Extended object properties are displayed when you open the properties dialog of a Natural object
in the Natural Server view. The properties displayed vary depending on the connected server
platform (Mainframe or Linux) and the selected Natural object type.

The prerequisite for displaying the extended properties is the connection to an NDV server/NSC
9.2.3 or higher on the mainframe and 9.3.2 or higher on Open Systems.

Debug Attach Server Available on Linux

The debug attach server is now available on Linux. The binary is delivered with the Natural for
Linux installation.

For more information about using the debug attach server, see Using Natural ONE > Using the De-
bugger > Using a Debug Attach Server.
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What's New in Version 9.3.2

SSL/TLS Security for Debug Attach Server

You can now start the debug attach server with SSL/TLS security. You can enable the SSL/TLS
security in the Natural-specific preferences.

For more information about using the debug attach server with SSL/TLS, see Using NaturalONE
> Using the Debugger > Using a Debug Attach Server.

Deployment

The deployment procedure now can process user exits.

See User Exits in Using Natural ONE > Deploying Natural Applications > Using the Deployment Wizard
for Natural Applications.

Editing a Filter or Filter Pattern for the Natural Server View

When defining filters for the Natural server view, it is now possible to edit existing filters and filter
patterns.

For further information, see Filtering Libraries and Objects in Using Natural ONE > Working with
Natural Objects in Natural Server Mode > Accessing a Remote Development Environment.

Downloading an Existing Library or Object from a Natural Server

When downloading a library from the Natural server into the workspace but any of the selected
objects already exist in the workspace, you can choose to skip all the duplicate objects with the
new "No to All" option. "No to All" skips all existing objects in the library and adds only the new
objects without any further user interaction.

For more information about downloading Natural libraries and objects from a Natural server, see
Downloading an Existing Library or Object from a Natural Server.

Collapse All Structures in Outline View

You can now collapse all structures with the "collapse all" icon in the Outline view of the Natural
Source editor, Map editor, and DDM editor.
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What's New in Version 9.3.2

Status Information of Natural Server

You can now see the error and warning information about a selected node in the Natural Server
view in the status bar of the Natural ONE perspective.

Libraries with different Fuser in NSC can now be handled in one project

With Natural Security it is possible to define a Fuser for a library, which differs to the main Fuser.
Up to now it was not possible to add such a library to a project, which has been created for other
libraries on the main Fuser.

The following functionalities are added with the new NaturalONE version:

® The Fuser of a library is retrieved from the secured server when the library is added to a project.

® The library properties dialog will show the library's Fuser on the 'Natural > Security' page.

Moreover, the current Fuser of a library is also retrieved with the 'NaturalONE > Update Library
Properties from Server' context menu of the library node.

This functionality requires at least NDV server/NSC 9.3.2 on Open Systems and 9.2.3 on Mainframe.
Monitoring and Modifying Variables Using the Eclipse Memory View

You can now use the newly-supported Eclipse Memory View while debugging Natural applications.

The Eclipse Memory View enables you to monitor the values of variables in Memory View. The
complete value of variables is displayed in hexadecimal representation, which is useful for large
variables of the type A, B, or U. You can also modify variable chunks or add renderings to see
values in ASCII or Unicode.

For more information, see Using the Debug Perspective in section Using Natural ONE.
Changing the Value of Variables from the Editor Area
Now you are able to change the value of a variable from the Editor Area. To do this, place the

cursor on the variable name, which you want to modify, invoke the context menu, and choose
Change Value.
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What's New in Version 9.3.2

Basic Functionality for Natural Application Development

Natural for Ajax / Ajax Developer

= Customization of Century Completion during Date Input

= Editing enhancements for ROWTABAREA, BMOBILE:TABPANE, and BMOBILE:VERTICALTABPANE
= Modernized Administration and Configuration Tools

= flushmethod in FIELD Control now supports JavaScript

= BMOBILE:ICON now supports popovers

= Enhanced error marking for BMOBILE:FIELD

= New version of Bootstrap lcons

= XCIPOPUPMENU Control: Field originatorquery has been removed

= BMOBILE:DROPDOWN and BMOBILE:DROPDOWNLIST now support Icons
= Responsive Contextmenus and Dynamic Menus Supported

= Enhanced Support for Bootstrap Icons

= BMOBILE:ALERT: New Property onclosemethod

= Single Sign-On (SSO) with OpendID Connect

= RCHART and RPIECHART Controls - chartjs 4.4.3

= New Ajax Configuration Parameter resetstatuspropfocus

= TEXT Control: New Property autowordwrap

Customization of Century Completion during Date Input

When entering date input values, the automatic century completion can be customized. See the
new cisconfig.xml setting completedateinputrange.

Editing enhancements for ROWTABAREA, BMOBILE:TABPANE, and BMOBILE:VERTICALTABPANE

When editing the controls ROWTABAREA, BMOBILE:TABPANE, and BMOBILE:VERTICALT-
ABPANE, Layout Painter now remembers the current tab when saving changes.

Modernized Administration and Configuration Tools
The tools for administration and configuration of Natural for Ajax applications are modernized.

The new package called "Runtime Tools" now contains the tools for Session configuration, Logging
configuration, Monitoring, and a new Ajax Configuration Editor to edit cisconfig.xml settings.
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What's New in Version 9.3.2

flushmethod in FIELD Control now supports JavaScript
Now you can also apply a JavaScript function as flushmethod in the FIELD Control.
BMOBILE:ICON now supports popovers

Use the new property popovertextidand the new css classes helpiconand helpicon-svgtoopen
popovers. See the Natural AjaxDemos for samples.

Enhanced error marking for BMOBILE:FIELD

The error marking of BMOBILE:FIELD in case of a wrong input has been enhanced. You can now
mark the container of the input field as an error. See the NaturalAjaxDemos for samples.

New version of Bootstrap Icons

More than 100 new icons available.

XCIPOPUPMENU Control: Field originatorquery has been removed

The field originatorquery is not generated for the XCIPOPUPMENU anymore.

BMOBILE:DROPDOWN and BMOBILE:DROPDOWNLIST now support Icons

Use the new properties icon/iconprop and withicon to add icons to your dropdowns. See the
NaturalAjaxDemos for samples.

Responsive Contextmenus and Dynamic Menus Supported

The XCIOPENPOPUP control is now also supported in responsive pages. It can be used to add
right-click context menus or general dynamic menus with button/icon activation. See the Natur-
alAjaxDemos for examples.

Enhanced Support for Bootstrap Icons

In NaturalONE, you can now conveniently select an icon font and copy the corresponding html
snippet to the Layout Painter editor or to your Natural editor. See chapter Ajax Developer.
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What's New in Version 9.3.2

BMOBILE:ALERT: New Property onclosemethod
You can now trigger an event in your Natural program when the end-user closes the alert.
Single Sign-On (SSO) with OpendID Connect

Natural for Ajax now supports single sign-on with OpenID Connect. For more information see
Configuring Single Sign-On (SSO)

RCHART and RPIECHART Controls - chartjs 4.4.3

The chartjs version for RCHART and RPIECHART has been upgraded to chartjs 4.4.3. See the
Migration Notes.

New Ajax Configuration Parameter resetstatuspropfocus

When using the statusprop values ERROR, FOCUS or FOCUS_NO_SELECT an automatic reset
is now supported so that the focus setting is only set once. See Ajax Configuration.

TEXT Control: New Property autowordwrap

The TEXT control now supports the property autowordwrap in combination with
maxrowlength/maxrowlengthprop and maxrows/maxrowsprop.
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What's New in Version 9.3.1

Environment

This section covers changes to prerequisites and requirements.
Eclipse and Java Versions

The Eclipse and Java versions have been updated. NaturalONE 9.3.1 is released with Eclipse 4.25
and Azul Java version 17.

Enhancements

This section describes new features and enhancements in NaturalONE's basic functionality for
Natural application development. It covers the following topics:

= Natural File Transfer for Linux
= DDM Editor

Natural File Transfer for Linux
Natural ONE now works as a client for Natural File Transfer for Linux. This includes support for
the DOWNLOAD PC FILE and UPLOAD PC FILE statements. Additionally, to the basic download
and upload functionality NaturalONE supports the 'SET PCFILE x DOWN/UP DATA' command
clause.
DDM Editor

= Support for New SQL Databases

Support for New SQL Databases

Starting with Natural version 9.3, the MariaDB database type is supported. For more information
about creating a DDM, see Creating a DDM.
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What's New in Version 9.3.1

Basic Functionality for Natural Application Development

= TQMARK Parameter
= Changes in the Details View Columns

TQMARK Parameter

Natural ONE now supports the TQMARK parameter when parsing sources in the Natural source
editor. If you are adding projects from an NDV server environment, the TQMARK parameter is
also downloaded to the Natural project properties.

Changes in the Details View Columns

The Mode and Server Encoding columns of the Details view of NaturalOne are no longer shown

by default. These columns can be switched on and off by opening the View menu and toggling
the menu items Show Column Mode and Show Column Server Encoding.

Natural for Ajax / Ajax Developer

= Xalan Replaced by a New Implementation

= Using Private-mode Libraries in Workplaces

= Removed Controls: LINECHART, NETMEETING and SKYPECALL
= New Responsive Control BMOBILE:CARD

= BMOBILE:DATATREE: New Property openonselect

= New Responsive Control BMOBILE:LISTGROUP

= BMOBILE:SIMPLEGRID: Frozen Columns

= BMOBILE:SIMPLEGRID: Keyboard Focus

= BMOBILE:SIMPLEGRID: New Property triggersearchprop
= BMOBILE:SIMPLEGRID: New Property withkeyboardfocus
= ROWTABLEAREAZ2: Frozen Columns

= Support of custom dates in DATEINPUT2

= Bootstrap-Icons Upgraded to Version 1.10.5

= TAB Key for DISPLAY Input Controls

= Generation of Parameter Data Area Supported

= Enhanced Accessibility Support
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What's New in Version 9.3.1

= NaturalAjaxDemos with Search and Navigation
Xalan Replaced by a New Implementation
The 3rd party Xalan component is not part of the product anymore. It has been replaced by a new
implementation that fully supports the functionality used in Natural for Ajax and NaturalONE.
In case you have been using features beyond this functionality in your Java components and dis-
cover issues, you can switch on the original Xalan support via the setting sdoful1xpath in ciscon-
fig.xml. For details see General cisconfig.xml Parameters > sdofullpath.

Using Private-mode Libraries in Workplaces

Using private-mode libraries in Workplace applications is now supported. For details see Using
Private-mode Libraries in Workplaces

Removed Controls: LINECHART, NETMEETING and SKYPECALL

The deprecated controls LINECHART, NETMEETING, and SKYPECALL have been removed
from the product. Instead, use RCHART and RPIECHART for chart controls .

New Responsive Control BMOBILE:CARD

BMOBILE:CARD ist a container control with options for headers, footers, images, text and more
content. For details, see BMOBILE:CARD

BMOBILE:DATATREE: New Property openonselect

Per default, tree nodes are opened when selecting the text of the corresponding node. Via the
property openonselect you can customize this behavior. See BMOBILE:DATATREE.

New Responsive Control BMOBILE:LISTGROUP
A list group displays a number of items as a vertical list. For details, see BMOBILE:LISTGROUP.
BMOBILE:SIMPLEGRID: Frozen Columns

The responsive grid BMOBILE:SIMPLEGRID now supports to freeze columns to the left and to
the right.
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What's New in Version 9.3.1

BMOBILE:SIMPLEGRID: Keyboard Focus

The responsive grid BMOBILE:SIMPLEGRID now supports keyboard navigation thru the single
columns of the grid.

BMOBILE:SIMPLEGRID: New Property triggersearchprop

Via the new property triggersearchprop, you can now set search values and trigger a search
from your Natural program. See BMOBILE:SIMPLEGRID.

BMOBILE:SIMPLEGRID: New Property withkeyboardfocus

Keyboard navigation for columns, rows and pages is now supported. Use the new property
withkeyboardfocus. See BMOBILE:SIMPLEGRID.

ROWTABLEAREA2: Frozen Columns

ROWTABLEAREA?2 with GRIDCOLHEADER controls now supports freezing columns to the left.
The number of frozen columns can be defined at design time, or dynamically at runtime, and via
click by the application's end-users. See section ROWTABLEAREA? - The Flexible Control Grid
Support of custom dates in DATEINPUT2

DATEINPUT2 now supports special handling of custom dates. See DATEINPUT2 — Custom Dates
Bootstrap-lcons Upgraded to Version 1.10.5

Version 1.10.5 contains over 1800 icons.

TAB Key for DISPLAY Input Controls

The file cisconfig.xml now supports the new settings displayallowtab. Use this setting to configure
whether tabbing into DISPLAY input controls is possible or not. See Ajax Configuration for details.

Generation of Parameter Data Area Supported

Optionally, you can now generate a Natural Parameter Data Area (PDA) for a layout. This PDA
avoids manual updates of Local Data Areas in your Natural programs in case of layout changes.

The context is explained in Natural Pages Development > Generating the Adapter.
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What's New in Version 9.3.1

Enhanced Accessibility Support

Many accessibility features have been added to the product, such as labels, language information,
and roles. Corresponding samples are available in the NaturalAjaxDemos. See section Accessibility

NaturalAjaxDemos with Search and Navigation

The NaturalAjaxDemos now come with search and navigation support to find and explore the
samples.
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What's New in Version 9.2.1

Security

= JDOM Removed
= Apache Logé4j has been replaced with Apache Log4j 2
= Deletion of Natural Passwords

JDOM Removed

JDOM has been removed from the product.
Apache Log4j has been replaced with Apache Logdj 2

For Code Generation the logging functionality is now based on Apache Log4j 2. For details, see
Code Generation > Using the Code Generation Component > Set Preferences > Set Logging Preferences.

If you have any Natural Unit Test Ant scripts created with a previous NaturalONE version, you
must migrate these scripts to the new format. For details, see Application Testing > Creating Ant
Scripts to Run Unit Tests > Migrate Existing Natural Unit Test Ant Scripts.

When running Natural Unit Test Ant scripts from the Command Line, special requirements must
be met. For details, see Application Testing > Creating Ant Scripts to Run Unit Tests > Running the
Natural Unit Test Ant Script from the Command Line.

Deletion of Natural Passwords

There is now a preference that the user can set which will cause all Natural passwords to be deleted
from secure storage every time NaturalONE is shut down.

Enhancements

This section describes new features and enhancements in NaturalONE's basic functionality for
Natural application development. It covers the following topics:
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What's New in Version 9.2.1

= DDM Editor
DDM Editor

= Additional Option for VSAM DDMs
= Support for New SQL Databases

Additional Option for VSAM DDMs

Starting with Natural Mainframe version 9.2, extended ISNs are supported for VSAM DDMs. A
new file attribute Extended file can be specified for this purpose. See Using the DDM Editor >
About the DDM Editor > Properties View for further information.

Support for New SQL Databases

Starting with Natural Mainframe version 9.2, the MySQL and PostgreSQL SQL database types are

supported. See Using Natural ONE > Using the Natural Editors > Using the DDM Editor for further
information about creating a DDM.

Basic Functionality for Natural Application Development

= | ist Natural Mainframe Libraries in the Natural Server View Using the Hyperdescriptor H2
List Natural Mainframe Libraries in the Natural Server View Using the Hyperdescriptor H2

When many libraries are available on the Natural system file, the listing of these objects in the
Natural Server view can take a long time. Starting from Natural for Mainframes version 9.2.1 on
z/OS, anew hyperdescriptor H2 is provided to significantly improve the database access required
for this purpose.

See Natural ONE in a Nutshell > Performance Aspects > Improve Mainframe Access for further information
about the available hyperdescriptors.

Natural for Ajax / Ajax Developer

= Java 11 Required

= Support for Tomcat10 and JBoss EAP

= | ong Username Support for Natural on Linux

= New Responsive Tutorial

= Customization of Whitespace handling for PDF Generation
= | ayout Painter: Support for Responsive Style Classes
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What's New in Version 9.2.1

= DATEINPUT2 and BMOBILE:DATEINPUTZ: new properties serverformat, clientformat, firstdayinweek
= F|ELD: new property placeholder

= ROWTABLEAREAZ: Export of Headers

= TEXTGRIDSSS2: new property cursormgtprop

= Customization of Responsive Style via SASS now Supported

= New Ajax Configuration Parameter notifyparentonpopupclosed

= Support PROCESS PAGE MODAL in Responsive Pages

= New Responsive Control: BMOBILE:DATATREE

= Support for <ctrl><enter> in BUTTON controls

= Removal of Deprecated Controls: BMOBILE:SIDENAV, BMOBILE:NAVTREE, BMOBILE:SIDENAV-
CONTENT

= NEWSFEED Control Deprecated

= Using Bootstrap 3 is Deprecated

= Deprecated: SWT Preview in Layout Painter

= Dependencies View now supported for Ajax Layouts

= New Configuration Settings for Natural for Ajax Updates

Java 11 Required

Java 11 is now required for development and production environments.

Support for Tomcat10 and JBoss EAP

Tomcat10 and JBoss EAP are now supported

Long Username Support for Natural on Linux

Long usernames support of Natural on Linux can now be used with Natural for Ajax.
New Responsive Tutorial

A responsive tutorial to develop a responsive mini-application is available. See First Steps Respons-
ive Pages.

Customization of Whitespace handling for PDF Generation
You can now customize the whitespace handling in CISFO:* and REPORT* controls. For more in-

formation see the chapter Working with PDF Documents > Advanced Data Binding and Rendering >
Whitespace Handling.
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What's New in Version 9.2.1

Layout Painter: Support for Responsive Style Classes

Layout Painter has extended the support for adding styleclasses on responsive pages. A corres-
ponding dialog allows convenient selection among the most popular classes for a control. A help
text explains the usage for each class.

DATEINPUT2 and BMOBILE:DATEINPUT2: new properties serverformat, clientformat, firstdayinweek

As of this version, the client date format (Browser), the server date format (Natural), and the first
day of the week, can be controlled via design-time properties.

All details are documented here:

Natural for Ajax > Working with Controls > DATEINPUT2 > Customizing Date and Calendar
Formats

Natural for Ajax >Responsive Page Layout and Controls > BMOBILE:DATEINPUT2 > Customizing
Date and Calendar Formats

FIELD: new property placeholder

In FIELD controls you can now add an initial placeholder text.

See Natural for Ajax > Natural Page Layout > Working with Controls > FIELD.
ROWTABLEAREAZ2: Export of Headers

Exporting the grid headers is now supported. It can be activated and deactivated dynamically.
Refer to Natural for Ajax > Working with Grids > ROWTABLEAREA?2 - The Flexible Control Grid.

TEXTGRIDSSS2: new property cursormgtprop
You can now dynamically reset the keyboard cursor of the grid from within your Natural program.
Customization of Responsive Style via SASS now Supported

You can now easily customize your responsive style via SASS variables. See Natural for Ajax > Re-
sponsive Natural Page Layout > Styling a Responsive Page.
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New Ajax Configuration Parameter notifyparentonpopupclosed

You can now customize whether or not a Natural program receives a "nat:page.default” event
when a pop-up is closed. .

Support PROCESS PAGE MODAL in Responsive Pages

Responsive pages now also support opening pop-ups dynamically via the Natural statement
PROCESS PAGE MODAL. For details, see section Natural for Ajax > Pop-Ups - Responsive Pages.

New Responsive Control: BMOBILE:DATATREE

The BMOBILE:DATATREE control is a responsive tree control, which supports levels deeper than 2
and dynamic loading of subtrees.

For details, see section Natural for Ajax > Responsive Natural Page Layout > Responsive Controls
Support for <ctri><enter> in BUTTON controls

Responsive and non-responsive BUTTON controls now support the activation via <ctrl><enter>.
This can be switched on for all buttons on a page. See the buttonctrlenter property in the
NATPAGE control.

This property can be switched on for all pages in the application. See the buttonctrlenter property
in the cisconfig.xml file !link.

Removal of Deprecated Controls: BMOBILE:SIDENAV, BMOBILE:NAVTREE, BMOBILE:SIDENAVCON-
TENT

The deprecated controls BMOBILE:SIDENAV, BMOBILE:NAVTREE, and BMOBILE:SIDENAVCONTENT have
been removed. Use BMOBILE: SIDEBAR*, BMOBILE:HORIZONTALBAR, BMOBILE:CONTENT, and the new
BMOBILE:DATATREE control instead.

NEWSFEED Control Deprecated

The NEWSFEED control is now deprecated. It requires rome-0.9.jar. The rome-0.9.jar is not packaged
with Natural for Ajax anymore. The rome-0.9.jar uses JDOM

JDOM has been removed from Natural for Ajax.
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Using Bootstrap 3 is Deprecated

Responsive pages per default use Bootstrap 4. Using Bootstrap 3 in responsive pages is deprecated.
Deprecated: SWT Preview in Layout Painter

The SWT preview in the Layout Painter has been deprecated. Use the HTML preview instead.
Dependencies View now supported for Ajax Layouts

You can now easily switch between a Natural program and the corresponding Layout via the
Dependencies View. For details, see Natural ONE > Natural for Ajax > Developing the Application
Code.

New Configuration Settings for Natural for Ajax Updates

Natural for Ajax Updates are now included in NaturalONE fixes. Configuration settings are
available to customize whether:

" updates are always or never applied automatically

" corresponding message boxes are shown.

For details, see section Natural ONE > Ajax Developer > Getting Started with Ajax Developer > Runtime
Environment Updates.
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What's New in Version 9.1.4

Security

= | ong User Ids
= JDOM Vulnerability

Long User Ids

In order to support security systems such as LDAP it is now possible to add up to 32 characters
in the User ID field of the Map Environment Dialog. If such a configuration is in place the entered
'Login-Id' will be mapped on the server side to the corresponding 8 Byte User Id. In all other
scenarios the normal User Id must be entered.

JDOM Vulnerability

The version of JDOM included in NaturalONE 9.1.4 contains the following vulnerability:

An XXE issue in SAXBuilder in JDOM through 2.0.6 allows attackers to cause a denial of service
via a crafted HTTP request.

https://nvd.nist.gov/vuln/detail/CVE-2021-33813

Within NaturalONE the vulnerable functionality from jdom 2.06 has been disabled. There are no
functional differences to be experienced by the user.

For users who are running Natural and Natural for Ajax on different machines we highly recom-
mend securing the Natural screen exchange by setting "Use SSL" in the session configuration. A
secure connection is then established between Natural for Ajax and the Natural Web I/O Interface
server that prevents attackers from exploiting this vulnerability. For more information see the
documentation of Natural for Ajax on Empower, Natural for Ajax > Release Notes > Security.

Enhancements

This section describes new features and enhancements in NaturalONE's basic functionality for
Natural application development. It covers the following topics:
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= Batch Model Support
Batch Model Support

NaturalONE now supports the Batch Model of Natural Construct Code Generation. It allows to
generate standardized batch applications using the new menu item BATCH of the sub menu Code
Generation > New Using Construct Model.

For further details, see Code Generation > Natural Construct Generation > Batch Wizard

Basic Functionality for Natural Application Development

= | jst Natural Mainframe Objects in the Natural Server View Using the Hyperdescriptor
= List Natural Mainframe Objects in the Natural Server View Using Filters

List Natural Mainframe Objects in the Natural Server View Using the Hyperdescriptor

When a library contains a huge number of objects, listing these objects in the Natural Server view
can take a long time. As of Natural for Mainframes version 9.1.2 on z/OS, a hyperdescriptor has
been introduced that can significantly improve the database access required for this purpose (phase
1). As of NaturalONE version 9.1.4 and Natural for Mainframes version 9.1.2 CF4, the performance
has been improved even further (phase 2).

The following image shows the elapsed times of the NDV server component. The library contains
in total about 15,000 objects, including 10,000 programs, 1,500 subprograms, and 100 subroutines.
Phase 1 and phase 2 use the hyperdescriptor.

List Objects in the Natural Server View
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The installation of the hyperdescriptor is described in Natural ONE in a Nutshell > Performance Aspects
> Improve Mainframe Access.

List Natural Mainframe Objects in the Natural Server View Using Filters

In previous versions of NaturalONE a shorter response time could be achieved by using a filter
with a fix prefix such as "A*". With NaturalONE 9.1.4 any filter can be used to reduce the response
time.

The following image shows a test of elapsed times for the NDV server component. The library
contains a total of about 15,000 objects. The filter "*1" lists all objects ending with "1", which delivers
705 of 10,000 programs, 101 of 1,500 subprograms, and 5 of 100 subroutines. For the subroutines,
the long names must be determined, which also costs some time. Mind, this test was performed
without using a hyperdescriptor. The reduction of elapsed time can be reduced even more by in-
stalling a hyperdescriptor.

List Objects "*1" in the Natural Server View

B NaturalONE 9.1.3 ® NaturalONE 9.1.4
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Changes to the Uls

= Project Explorer View
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= Natural Navigator
Project Explorer View
In the Natural perspective, the deprecated Navigator view has been replaced by the Project Explorer
view. The Project Explorer view supports all NaturalONE context menus and toolbar commands
that were formerly supported by the Navigator view.

Natural Navigator

The Natural Navigator view has been enhanced:

® The former 'character' tool bar buttons have been replaced with new icons

® The context menu items Testing, Business Services and Code Generation are now also available
in the Natural Navigator view.

Natural Tools and Utilities

This section describes new features and enhancements concerning Natural tools and utilities
available in NaturalONE. It covers the following topics:

= Natural Profiler Rich GUI
Natural Profiler Rich GUI

The Natural Tools and Utilities in NaturalONE offers a new rich GUI interface for the Natural
Profiler. The Natural Profiler page lists all Profiler resources of a given library. For a selected
Profiler resource, the properties and statistics of the profiling are displayed. Functions are available
for consolidate or evaluate Profiler data, to analyze monitored programs, or to delete a resource

file.

For more information, see Using Natural ONE > Using Natural Tools and Utilities > Rich GUI Interface
of the Natural Profiler.
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Natural for Ajax / Ajax Developer

= Edge Chromium Browser

= Bootstrap Icons Library

= New Responsive Controls: BMOBILE:COMBOFIX, BMOBILE:COMBODYN
= New Responsive Dropdown Controls

= Responsive Controls with new Properties straighttext

= Responsive Controls with new Properties titlestraighttext

= BMOBILE:SIMPLEGRID: Server-Side Scrolling and Sorting

= BMOBILE:FFIELD: new property withtogglepassword

= |TR with New Property inline

= REPORT and REPORT2 Controls with New Property nameprop

Edge Chromium Browser
With this version of Natural for Ajax the Edge Chromium Browser is now supported.
Bootstrap Icons Library

The Bootstrap Icons Library is now part of the Natural for AJAX product. It can be used in respons-
ive and non-responsive controls in different ways. See section Working with Icons.

New Responsive Controls: BMOBILE:COMBOFIX, BMOBILE:COMBODYN

The BMOBILE:COMBOFIX and BMOBILE:COMBODYN are light-weight selection controls.

For details, see section Natural for Ajax > Responsive Natural Page Layout > Responsive Controls
New Responsive Dropdown Controls

The controls BMOBILE: DROPDOWN, BMOBILE:DROPDOWNLIST, BMOBILE: DROPDOWNHEADER,
BMOBILE:DROPDOWNITEM, BMOBILE:DROPDOWNSEPARATOR support various dropdown functionality
such as dropdown menus and dropdown forms.

For details, see section Natural for Ajax > Responsive Natural Page Layout > Responsive Controls
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Responsive Controls with new Properties straighttext

All responsive controls with a name/nameprop property now also supporta straighttext property.
Via this property, the name value can be rendered either as html or as straight text.

Responsive Controls with new Properties titlestraighttext

All responsive controls witha title/titleprop property now alsosupportatitlestraighttext
property. Via this property, the tooltips can be rendered either as html or as straight text.

BMOBILE:SIMPLEGRID: Server-Side Scrolling and Sorting

The responsive grid BMOBILE: SIMPLEGRID now supports Server-Side Scrolling and Sorting.
BMOBILE:FFIELD: new property withtogglepassword

For password fields you can now add an icon to toggle the password visibility.

ITR with New Property inline

ITR controls now support inline rendering via the new inline property. This improves the ren-
dering when zooming pages in Google Chrome or Edge Chromium browsers. See section Natural
for Ajax > Working with Containers> Positioning of Controls inside a Container > ITR in Google Chrome
and Edge Chromium.

REPORT and REPORT2 Controls with New Property nameprop

The REPORT and REPORT?2 controls now also support to set the name dynamically at runtime
via the property nameprop.
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Installation

Software AG Designer 10.7, which includes Natural ONE, uses Eclipse Version 4.15. If you prefer
to use NaturalONE in your existing Eclipse environment, see also Using Your Own Eclipse in the
Installation documentation.

The selection of components during the installation has changed. For more information, see Installing
Natural ONE in the Installation documentation.

Deployment Package
After installing NaturalONE and applying all relevant fixes, you are now able to create a compressed

package of Natural ONE for deployment on additional development stations. For more information,
see Preparing a Deployment Package in the Installation documentation

Basic Functionality for Natural Application Development

This section describes new features and enhancements in NaturalONE's basic functionality for
Natural application development. It covers the following topics:

= DDMs in the Server View
= List Natural Mainframe Objects in the Natural Server View
= ECHECK

DDMs in the Server View

The preference Display DDMs in library is no longer available. Displaying DDMs in the Natural
server view has been enhanced in the following way:

For Natural Development (NDV) servers which are protected with Natural Security, all DDMs
which are accessible to the current user in a specific library are shown in a DDMs group node of
this library, regardless of whether the DDMs are public or protected. The DDMs system file node
is no longer available in this case.

If the NDV server is not protected with Natural Security, the DDMs will either be displayed below
the DDMs system file (Mainframe server or servers with FDDM) or in the DDMs group node of the
libraries (for Linux, or Windows environments without FDDM).

This new behavior is also described under Working with DDMs in section Managing Objects Directly
on a Natural Server.
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List Natural Mainframe Objects in the Natural Server View

When a huge number of objects are contained in a library, the listing of these objects in the Natural
Server view can take a long time. Natural for Mainframes Version 9.1.2 on z/OS provides a new

hyperdescriptor that can significantly improve the database access required for this purpose. The
installation of the hyperdescriptor is described in Performance Aspects in NaturalONE in a Nutshell.

ECHECK

The ECHECK parameter is now supported in NaturalONE when parsing sources in the Natural
source editor. When adding projects from an NDV server environment, the ECHECK parameter is
also downloaded to the Natural project properties. This enhancement does currently not apply to
NDV mainframe servers.

Natural Tools and Utilities

This section describes new features and enhancements concerning Natural tools and utilities
available in NaturalONE. It covers the following topics:

= Debugger
= Natural Profiler
= Natural Data Browser

Debugger

The debugger has been enhanced to show the complete value of a large or dynamic variable of
the type A, U or B. See Display Options in Setting the Preferences and Variables View in Debugging
Natural Applications for further information.

In order to provide the variable chunk support for large and dynamic variables, a Natural server
change is necessary. This means that the functionality is only available with the most current
versions of the Natural Development (NDV) servers on Linux and Windows that correspond to
NaturalONE Version 9.1.3.
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Natural Profiler

A new drop-down list box which is shown at the top of the Hot Spots page allows switching
between different built-in display layouts. See Viewing the Profiler Output > Hot Spots in Using
the Natural Profiler for further information.

The default layout that is initially used can be set in the Natural preferences. See Profiler > Hot
Spots in Setting the Preferences for further information.

Natural Data Browser

The data browser now supports Adabas protected files. See Creating a Report Template in Using the
Data Browser for further details.

In addition, to use the maximum number of occurrences for periodic groups and multiple fields
in Adabas files, a new preference has been introduced. For details see Displaying the Properties for
a Field in Using the Data Browser and Data Browser in Setting the Preferences for further details.

Deploying Natural Applications

This section describes new features and enhancements in the NaturalONE deployment area. It
covers the following topics:

= New Optional Batch Deploy in Predict
New Optional Batch Deploy in Predict

A new functionality has been added to Predict which allows you to deploy from a batch file. For
more information, check Managing Predict Components > Steps required in your Natural Project(s).

Eclipse-Independent Application Testing

It is now possible to execute a Natural unit test bed with an Ant script outside the context of a
NaturalONE/Eclipse environment. This is especially important for providing full DevOps support
if you also want to execute test cases unattended in a lean command line environment. This exten-
sion will also simplify the integration of Natural unit test processing with continuous integration
tools like Jenkins.

The functionality of writing Natural unit test cases is already covered by NaturalONE. However,
this has now been extended with a new Natural unit test Ant Script wizard, which can be used to
generate Ant based testing scripts. These scripts support several targets like checkout for checking
out a test project or unittest for executing a Natural unit test bed.
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For testing purposes, you can now also execute a testing Ant script inside NaturalONE via the
Eclipse built in Run As Ant Script functionality. The results of a test run will be displayed in the
Console view.

Refer to Creating Ant Scripts to Run Unit Tests in the Application Testing documentation for further
details.

Natural for Ajax / Ajax Developer

This section describes new features and enhancements in Natural for Ajax and Ajax Developer.
It covers the following topics:

= Responsive NatLogon and NatDisconnect Pages Supported

= Bootstrap 4 Supported in Responsive Pages

= Support for Natural-specific Properties like njx:natname in Responsive Controls
= PAGEBODY Container obsolete for Responsive Controls

= New Template for Responsive Pages with Sidebar

= Major Enhancements of Responsive Forms

= BMOBILE:COL.: visisbleprop now supported

= Enhanced Testing Support for Responsive Controls

= New Responsive Containers: BMOBILE:SIDEBAR*, BMOBILE:HORIZONTALBAR, BMOBILE:CON-
TENT

= Help IDs supported in Responsive Input Controls

= Enhanced Tooltip Support for Responsive Controls

= Page Pop-Ups Fit to Parent

= F|ELD Control: New Value in Property formautocomplete Supported

= F|ELD Control With New properties onclickmethod and ondblclickmethod

= RPIECHART With New Property animateselection

= Several Responsive Modal Enhancements

Responsive NatLogon and NatDisconnect Pages Supported
Responsive and non-responsive NatLogon and NatDisconnect pages are now supported. In Nat-

uralONE you can create your own custom NatLogon and NatDisconnect pages using the New
layout wizard.
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Bootstrap 4 Supported in Responsive Pages

Bootstrap 4 is now supported for responsive controls. Bootstrap 4 is the default. If you still need

to use Bootstrap 3, you can use the attribute uselatestbootstrap in cisconfig.xml to run all pages
with Bootstrap 3 or use the property uselatestbootstrap in the NATPAGE control to run a single
page with Bootstrap 3

See Ajax Configuration for details.
Support for Natural-specific Properties like njx:natname in Responsive Controls

Most responsive controls now support Natural-specific properties like njx:natname in the same
way as non responsive controls.

PAGEBODY Container obsolete for Responsive Controls

The PAGEBODY tag is now obsolete for responsive controls. The templates for responsive pages do
not contain the PAGEBODY tag anymore. Responsive pages with PAGEBODY tags are still supported
but contain obsolete HTML code.

New Template for Responsive Pages with Sidebar

The Layout Painter supports a new page template for development of responsive pages with
sidebars. See also Responsive Page Layout and Controls for further details.

Major Enhancements of Responsive Forms

A more flexible and lightweight BMOBILE : FORM container is now supported. The BMOBILE - FORMGROUP
containers now supports horizontal and vertical forms. For the usage in bar controls - like the
BMOBILE:HORIZONTALBAR and the BMOBILE: SIDEBAR-aBMOBILE: FORMINLINE container is supported.
A BMOBILE:FTEXTOUT control has been added to support plain read-only text in forms.

BMOBILE:COL.: visisbleprop now supported

The BMOBILE:COL container now supports a visibleprop property.
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Enhanced Testing Support for Responsive Controls

Most responsive containers and controls now support a testtoolid property.

New Responsive Containers: BMOBILE:SIDEBAR*, BMOBILE:HORIZONTALBAR, BMOBILE:CONTENT

The new responsive containers BMOBILE: STDEBAR*, BMOBILE:HORIZONTALBAR and BMOBILE: CONTENT
support frequently used patterns for modern responsive pages.

Additional controls like BMOBILE: TOGGLER, BMOBILE: SIDEBARGROUP, BMOBILE: BARTEXT support
corresponding functionality for flexible rendering.

Help IDs supported in Responsive Input Controls

Responsive input controls like BMOBILE: FFIELD now support a helpid property in the same way
as non-responsive controls.

Enhanced Tooltip Support for Responsive Controls

Bootstrap 4 tooltip support is now used to render tooltips. The rendering can be customized via
CSS style classes. All form controls now also support setting the tooltip text dynamically from
within Natural. Use the property titleprop in the corresponding controls.

Page Pop-Ups Fit to Parent

The file cisconfig.xml now supports the new settings pagepopuponresize, pagepopuphorizontal
and pagepopupvertical. Use these settings to fit a page pop-up to its parent.

See Ajax Configuration for details.
FIELD Control: New Value in Property formautocomplete Supported
The formautocomplete property of the FIELD and BMOBILE: FFIELD controls now supports the

value new-password. In the current versions of Chrome, this can be used to prevent Chrome from
autofilling form fields.
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FIELD Control With New properties onclickmethod and ondblclickmethod

Natural programs can now react to click and/or double click events. Refer to the description of
the FIELD control properties for details.

RPIECHART With New Property animateselection

Use the new RPIECHART property animateselection if you want to render the selected slice with
a bigger radius (= move out effect).

Several Responsive Modal Enhancements

A new BMOBILE:HELPMODAL dialog shows help texts for specified help IDs. All responsive modal
dialogs - BMOBILE:MODAL, BMOBILE: INTMODAL, BMOBILE: HELPMODAL - are now draggable and resizable.

For BMOBILE:MODAL, the page URL can now be specified dynamically at runtime.

Optional Components

New features are available with the following optional components. For detailed information on
the new features, see the Release Notes in the documentation of the corresponding optional com-
ponent.

Placeholder

Placeholder. Add text here...

Documentation

The Natural ONE in a Nutshell documentation has been enhanced. A new section Performance Aspects
has been added, providing information on what actions and best practices can improve the per-
formance.

42 Release Notes



What's New in Version 9.1.3

Known Issues

Subclipse NullPointerException

If you are working with the SVN Repository Exploring Perspective or Views, it might happen that
a dialog with a Nul1PointerException pops up. This problem has been observed especially, if
you switch from the SVN perspective to the Natural ONE perspective.

This is a known Subclipse problem which is described in the following Subclipse issue: https://git-
hub.com/subclipse/subclipse/issues/126.

Even if it is annoying, you can ignore this exception.
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Basic Functionality for Natural Application Development

This section describes new features and enhancements in NaturalONE's basic functionality for
Natural application development. It covers the following topics:

= Enhanced RTL Language Support

= SSL Support

= Support Old Internal Data Area Format
= Customizable Coloring in the Map Editor

Enhanced RTL Language Support

The support for right-to-left (RTL) languages has been enhanced. In particular, the bidirectional
settings such as layout orientation, visual order and Arabic shaping are now maintained on a per-
project basis. As such, they can be exported to a Natural project file (.natural) together with the
other project properties and persisted in a user's source repository. In addition, these settings are
initialized from the current server settings if possible, in order to reduce the time and effort required
for configuration.

This is reflected in modified options when setting Natural ONE preferences and/or changing the
properties of Natural projects in local mode. Refer to Regional Settings in Setting the Preferences and
Regional Settings in section Changing the Project Properties of Managing Natural Projects for further

details.

SSL Support

It is now possible to establish SSL-secured connections to Natural Development (NDV) servers
(running on version 9.1.2 or above).

This is reflected in modified options when setting Natural ONE preferences and/or changing the
properties of Natural projects in local or server mode. Refer to Using SSL for further details.

Support Old Internal Data Area Format

| Note: The following only applies when Natural on Linux and Cloud Version 9.1.2 and above
or Natural for Windows Version 9.1.2 and above are being used as a development server.

During upload or update to the server, all types of data area sources (local, parameter and global)
will no longer be converted into the old internal data format but will be saved as defined with the
NaturalONE Source Editor. Therefore the option Support old internal data area format will be
ignored. For details refer to Options in section Natural under Setting the Preferences for details.
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Customizable Coloring in the Map Editor

It is now possible to customize the colors of specific syntax elements displayed in the map editor.
Refer to Map Editor under Setting the Preferences for details.

Natural Tools and Utilities

The list of Natural tools and utilities now also comprises the following:

Tool Platform

Adabas Event Replicator ~ |Mainframe

Adabas Online System Mainframe

Adabas Review Mainframe

Adabas Statistics Facility ~ |Mainframe

Natural Ajax Demos Windows

Natural Security All

Predict Application Audit |Mainframe

Predict Application Control| Mainframe

zIIP Statistics Mainframe

A tool is only shown if the corresponding application is installed.

= Security Validation
= Setting Filters

Security Validation

If an entry in the list of Natural tools and utilities derives from an XML member delivered by
Software AG (which are named SAG-*.XML), it will only be displayed in the list of tools if Natural
Security (if used) allows you to log on to the given library and execute the given command.

Setting Filters

If you add your own tools to the list of the Natural tools and utilities, you may specify filters so
that the tool is only listed if certain conditions are met.

For further information, see Extend the List of Tools and Utilities.
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Natural for Ajax / Ajax Developer

This section describes new features and enhancements in Natural for Ajax and Ajax Developer.
It covers the following topics:

= New Ajax Configuration Parameter urlopenstreetmapgeocoder

= AUTOCOMPLETE supports limiting the results shown in a drop-down box
= DATEINPUT2 with new Properties stylevariant and displayprop

= New Control REPORT2

= New Ajax Configuration Parameter maxserverlogage

= Support for editable columns in BMOBILE:SIMPLEGRID

= ROWTABLEAREAZ supports Export to Clipboard and File

= ROWTABLEAREAZ supports Icon Bars

= | ayout Generation Enhancements

= Switch off Server Logging

= New Responsive Control BMOBILE:ICONCOL

= Responsive Modal Controls

= |con Support in Responsive Controls

= | ayout Painter - Error Property Selection

= Ajax Developer Supported in Natural Navigator View

= Grouping of Objects Supported for Ajax Enabled Natural Projects

New Ajax Configuration Parameter urlopenstreetmapgeocoder

You can now adapt the third party geocoder URL in the Ajax configuration file if needed.
AUTOCOMPLETE supports limiting the results shown in a drop-down box

The AUTOCOMPLETE control now enables you to limit the results shown in the drop-down box.
The AUTOCOMPLETE control now also has a new property maxresults. The FIELD control now
has a new property autocompleteresultsref.

DATEINPUT2 with new Properties stylevariant and displayprop

DATEINPUT2 now supports the properties stylevariant and displayprop in the same way as
the FIELD control.

48 Release Notes



What's New in Version 9.1.2

New Control REPORT2

The REPORT?2 control supports PDF report generation in responsive and non-responsive design.
In difference to the REPORT control, it does not require to additionally render the data in the
HTML pages.

New Ajax Configuration Parameter maxserverlogage

Automatic cleanup of ServerLog*.log files is now supported. You can configure the maximum
storage age of ServerLog*.log files in days in the Ajax configuration file.

Support for editable columns in BMOBILE:SIMPLEGRID

BMOBILE:SIMPLEGRID now fully supports editable columns also on small devices.
ROWTABLEAREA2 supports Export to Clipboard and File

In ROWTABLEAREAZ2, all or just the selected items can now be copied to the clipboard or exported
to a file. See Export to Clipboard and File in the description of the ROWTABLEAREA2 control grid

for further details.

ROWTABLEAREA2 supports Icon Bars

ROWTABLEAREAZ2 supports the new controls ICONBAR, ICONBARLINE, TOCLIPBOARDICON,
TOFILEICON and BLOCKSCROLLINGBAR. See Icon Bars in the description of the
ROWTABLEAREAZ2 control grid for further details.

Layout Generation Enhancements

Performance of Layout generation has been improved. Also the analysis of generation errors has
been simplified. See the new attribute htmlgeneratorlog in the Ajax Configuration section.

Switch off Server Logging

You can now switch off writing log information to the server log. See 1oglevel in the Ajax Config-
uration section.
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New Responsive Control BMOBILE:ICONCOL
BMOBILE:SIMPLEGRID now supports icon columns. See BMOBILE:ICONCOL for details.
Responsive Modal Controls

A set of responsive modal controls has been added:

* BMOBILE:INTMODAL,

* BMOBILE:INTMODALHEADER,
* BMOBILE:INTMODALBODY,

* BMOBILE:INTMODALFOOTER.

Icon Support in Responsive Controls

Many responsive controls now support icons as values for name/nameprop or as value for other
text based properties. For examples see the Natural for Ajax Demos.

Layout Painter - Error Property Selection

On double-click in the Problems view now not only the control but also the erroneous property
is selected in Layout Painter.

Ajax Developer Supported in Natural Navigator View
Ajax functionality is now supported in the Natural Navigator View.
Grouping of Objects Supported for Ajax Enabled Natural Projects

The grouping of objects by object type is now also supported for Ajax enabled projects.
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Using NaturalONE in Your Own Eclipse Environment

The easiest and recommended way to install Natural ONE is to make use of the Software AG In-
staller. However, you may prefer to make use of your already existing Eclipse environment. A
short description how to achieve this can be found in the section Using Your Own Eclipse in the
Installation documentation.

Installation

The Software AG Designer 10.3, which includes NaturalONE, uses Eclipse Version 4.7.3a. If you
prefer to use NaturalONE in your existing Eclipse environment, Eclipse Version 4.7.3a is required.
In addition, Java 1.8 is required. See also Using Your Own Eclipse in the Installation documentation.

Support of Windows 7 Professional Edition - x86-64

NaturalONE Version 9.1.1 under Windows 7 Professional Edition - x86-64 will be supported until
January 31st, 2020.

Basic Functionality for Natural Application Development

This section describes new features and enhancements in NaturalONE's basic functionality for
Natural application development. It covers the following topics:

= Renamed and Modified Option in the Runtime Execution Preferences
= Clean Project on Update from Repository
= File Transfer

Renamed and Modified Option in the Runtime Execution Preferences

The option Expand Natural server view on reconnect has been enhanced and renamed to Restore
Natural Server View.

For further details please refer to Runtime Execution in Setting the Preferences.
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Clean Project on Update from Repository

When a Natural project in the workspace is updated from a repository location the .natural file of
the project may also be modified.

Depending on the setting of the preference Update project properties automatically on .natural
file modification in the Natural Project preferences, the new properties coming with the updated
.natural file are propagated to the project and will immediately come into effect.

On changes of the runtime properties, the project's server environment may possibly no longer
be in synch with the project's builder information, e.g. Natural objects existing in the project in
the workspace may be missing in the new server environment. This may lead to Natural errors
on the project's build, update or upload functions. Executing the function Clean function in a

project ensures that the project in the workspace will be in synch with the server environment.

The Clean function is now executed automatically for a project when one of the following properties
is changed in the .natural file:

®" Host Name

" Port Number

" Session Parameters

® FUSER
Prerequisite

The preference Update project properties automatically on .natural file modification must be
checked in the Natural Project preferences.

Properties Dialog

The automatic Clean of a project is not performed when the projects server environment is modified
using the Properties dialog. Here the user must take care on his own and issue the Clean function
for the project manually when the modifications have been done.

For further details on the Clean function see also Understanding the Behavior of the Natural Builder,
Builder in the Natural preferences and Modifying Objects in the Natural Environment or in the Repos-
itory.
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File Transfer

Natural ONE now supports File Transfer. This functionality is currently only available when ex-
ecuting applications on mainframe-based NDV (Natural Development) servers.

Refer to File Transfer in section Setting the Preferences for details.

Deploying Natural Applications

This section describes new features and enhancements in the NaturalONE deployment area. It
covers the following topics:

= Switching the Security Mode

= Using Project References

= Scratching Objects on the Server

= \Writing a History Log File

= Creation of SYSOBJH Workplans

= Recognition of the FNAT SYSTEM Library

= Handling of Upload Errors

= Performance of the NaturalONE Deployment Run
= Starting the Deployment from the Command Line

Switching the Security Mode

The security mode used in the Natural ONE deployment wizard can now be switched independently
from the mode set in the Natural server environment. Refer to the description given under Steplibs
in the section Using the Deployment Wizard for Natural Applications for details.

Using Project References

References between NaturalONE projects can now be handled also in the Natural ONE deployment

scripts. See section Project References in the section Using the Deployment Wizard for Natural Applic-
ations and Project References Handling for detailed information.
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Scratching Objects on the Server

The Natural ONE deployment scripts can now record the deletion of objects in the workspace and
scratch the corresponding objects on the server during the next deployment run. See the description
for the option Scratch server objects description under General Settings in the section Using the
Deployment Wizard for Natural Applications.

Writing a History Log File

The NaturalONE deployment scripts can be enabled to write history log files during processing.
For more information refer to Logging in the section Using the Deployment Wizard for Natural Applic-
ations.

Creation of SYSOBJH Workplans

The Natural ONE deployment scripts can be enabled to generate SYSOBJH workplans which can
be used to replay the actions performed by the Natural ONE deployment scripts in pure server
environments. For more information refer to Logging in the section Using the Deployment Wizard
for Natural Applications.

Recognition of the FNAT SYSTEM Library

The NaturalONE deployment scripts can now handle the special file number "-2" which can be
used to refer to the SYSTEM library in FNAT. See Steplibs in the section Using the Deployment
Wizard for Natural Applications for details.

Handling of Upload Errors

Upload errors that occur during the NaturalONE deployment run are now handled similar to
catalog or stow errors so that the corresponding object is marked for a retry during the next de-
ployment run.

Performance of the NaturalONE Deployment Run

During NaturalONE deployment runs with incremental mode enabled the objects that need to be
processed have to be calculated depending on the scope level that has been selected (see Controlling
the Scope of Files to be Processed for details). The performance of these calculations has been enhanced,
especially for large applications with many objects and especially for the initial (first) deployment
run.
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Starting the Deployment from the Command Line
In addition to the already required JAR files for running the deployment script, another new JAR

file is required now. For more information refer to Prerequisites in the section Starting the Deployment
from the Command Line.

Natural for Ajax / Ajax Developer

This section describes new features and enhancements in Natural for Ajax and Ajax Developer.
It covers the following topics:

= Responsive Tab Controls

= BMOBILE:ALERT with new Property duration

= BMOBILE:PANEL with new Property foldedprop

= BMOBILE:FORMAREA with new Properties legendprop, visibleprop and invisiblemode
= BMOBILE:FORMAREA with new Properties textid and nameprop

= BMOBILE:FORMGROUP with new Properties visibleprop and invisiblemode
= BMOBILE:CHECKBOX with new properties

= New Responsive Control BMOBILE:RADIOBUTTON

= New Responsive MEDIA Controls

= New Responsive Side Navigation Controls

= BMOBILE:NAVBAR with new Property brandstraighttext

= BMOBILE:SIMPLEGRID with Editable Columns

= DATEINPUT2: Custom Holiday Rendering

= DATEINPUT2 with new Property popuponF4F7

= DATEINPUT and DATEINPUT2 support Property testtoolid

= NaturalAjax Samples

= PDF Reports - Upgrade to Version FOP 2.2

= CSVCOLUMN supports Properties njx:natname and njx:natstringtype

= Responsive Style Guide

Responsive Tab Controls

A set of responsive tab controls has been added:

® BMOBILE:TABPANE,
BMOBILE:VERTICALTABPANE,
BMOBILE:TAB,
BMOBILE:TABSUBPAGES,
BMOBILE:VERTICALTABSUBPAGES,
BMOBILE:STRAIGHTTAB,
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" BMOBILE:PAGER.
BMOBILE:ALERT with new Property duration

For the BMOBILE:ALERT control, you can now define the duration after which the alert box will
disappear.

BMOBILE:PANEL with new Property foldedprop

For the BMOBILE:PANEL container, you can now control the folded state dynamically from your
Natural program.

BMOBILE:FORMAREA with new Properties legendprop, visibleprop and invisiblemode

For the BMOBILE:FORMAREA container, you can now control the visible state and the name of
the legend dynamically from your Natural program.

BMOBILE:FORMAREA with new Properties textid and nameprop

For the BMOBILE:FORMAREA container, you can now dynamically define the name from your
Natural program and from multilanguage files.

BMOBILE:FORMGROUP with new Properties visibleprop and invisiblemode

For the BMOBILE:FORMGROUP container, you can now control the visible state and the name
of the legend dynamically from your Natural program.

BMOBILE:CHECKBOX with new properties
Some advanced properties have been added to the BMOBILE:CHECKBOX control.
New Responsive Control BMOBILE:RADIOBUTTON

A responsive radio button control BMOBILE:RADIOBUTTON is now available.
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New Responsive MEDIA Controls

The responsive controls BMOBILE:VIDEO, BMOBILE:MEDIAUPLOAD, and corresponding sub-
controls have been added to integrate and upload media objects.

New Responsive Side Navigation Controls

The controls BMOBILE:SIDENAV, BMOBILE:NAVTREE and BMOBILE:SIDENAVCONTENT
support the implementation of responsive side navigation using a responsive navigation tree.

BMOBILE:NAVBAR with new Property brandstraighttext

For the BMOBILE:NAVBAR control, you can now set text and images as value of the brandprop
property. Via the new property brandstraighttext you can distinguish between the representation.

BMOBILE:SIMPLEGRID with Editable Columns

The BMOBILE:SIMPLEGRID control now supports editable columns. See the corresponding
sample in the Natural Ajax Demos for details.

DATEINPUT2: Custom Holiday Rendering

Support to render custom holidays in different style has been added to the DATEINPUT2 control.
For details, please refer to he new properties HOLIDAYS* and the corresponding sample in the
Natural Ajax Demos.

DATEINPUT2 with new Property popuponF4F7

For the DATEINPUT?2 control, you can now customize whether or not the calendar should open
on using the F4 or F7 key.

DATEINPUT and DATEINPUT2 support Property testtoolid
The DATEINPUT and DATEINPUT2 controls now support the property testtoolid.
NaturalAjax Samples

The samples now contain an additional user interface component with performance hints for non-
responsive layouts and containers.
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PDF Reports - Upgrade to Version FOP 2.2
FOP 2.2.is now used for the PDF report generation in Natural for Ajax. This version requires more

Java memory. When using this feature you might have to increase the configuration settings for
Java memory in your web application server.

For details concerning Java memory settings, please refer to the documentation of your web ap-
plication server.

CSVCOLUMN supports Properties njx:natname and njx:natstringtype
The CVSCOLUMN control now supports the properties njx:natname and njx:natstringtype.
Responsive Style Guide

For responsive pages a style guide is now available. You find the latest version in the Natural A-
jaxDemos NaturalONE project.

Natural Tools and Utilities

The new SYSUTIL utility enables you to start selected Natural tools and utilities from Natural ONE.
In general, it starts character based tools on the server side. Additionally, it offers new rich GUI
interfaces to the SYSEXT and SYSEXV utilities and a rich GUI tool to retrieve error messages.

The list of tools provided in SYSUTIL can be extended so that it also shows your own tools and
applications.

For detailed information see Using Natural Tools and Utilities in the Using Natural ONE document-
ation.

NaturalONE in a Citrix Environment

NaturalONE can be installed and is supported running under Windows Remote Desktop Services
on all from Software AG supported Windows Server Platforms allowing parallel user access via
Windows remote desktop connections. NaturalONE is also intended to be installed and to run on
Citrix Xenapp environments. However issues caused by NaturalONE that are related to the Citrix
Xenapp environment or its configuration need to be reproduced under Windows Remote Desktop
Services on a currently supported Windows Server platform first before further analysis can take
place.
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